Evaluating the AD7402 16-Bit, Isolated Sigma-Delta ADC

FEATURES
- Full featured evaluation board for the AD7402
- On-board power supplies
- Standalone capability
- Compatible with the EVAL-SDP-CH1Z system demonstration platform-high speed (SDP-H1) controller board
- PC software for control and data analysis

EVALUATION KIT CONTENTS
- EVAL-AD7402-8FMCZ evaluation board
- CD containing evaluation software for the AD7402
- AD740x Evaluation Software

ADDITIONAL EQUIPMENT NEEDED
- EVAL-SDP-CH1Z, includes a USB cable and 12 V wall wart
- Signal source
- PC running Windows Vista or Windows 7 with USB 2.0 port

ONLINE RESOURCES
- Documents Needed
  - AD7402 data sheet
  - EVAL-AD7402-8FMCZ user guide
- Required Software
  - AD740x Evaluation Software
- FAQs and Troubleshooting

GENERAL DESCRIPTION
The EVAL-AD7402-8FMCZ is a full featured evaluation board that allows the user to easily evaluate all the features of the AD7402 isolated analog-to-digital converter (ADC). The evaluation board can be controlled by the SDP-H1 board (EVAL-SDP-CH1Z) via the FMC connector (J9). The SDP-H1 board allows the evaluation board to be controlled through a USB port of a PC using the evaluation board software, which is available for download from the EVAL-AD7402-8FMCZ product page or from the installer CD included in the evaluation board kit.

On-board components include the following:
- **ADuM6000**: isolated iCoupler®, 5 kV, dc-to-dc converter
- **ADP2441**: 36 V, 1 A, synchronous, step-down dc-to-dc regulator
- **ADP7104ARDZ-5.0**: 5 V, low noise LDO

TYPICAL SETUP

![TYPICAL SETUP Diagram](image-url)

Figure 1. Typical Setup (EVAL-AD7402-8FMCZ on Left and EVAL-SDP-CH1Z on Right)
**TABLE OF CONTENTS**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Features</td>
<td>1</td>
</tr>
<tr>
<td>Evaluation Kit Contents</td>
<td>1</td>
</tr>
<tr>
<td>Additional Equipment Needed</td>
<td>1</td>
</tr>
<tr>
<td>Online Resources</td>
<td>1</td>
</tr>
<tr>
<td>General Description</td>
<td>1</td>
</tr>
<tr>
<td>Typical Setup</td>
<td>1</td>
</tr>
<tr>
<td>Revision History</td>
<td>2</td>
</tr>
<tr>
<td>Getting Started</td>
<td>3</td>
</tr>
<tr>
<td>Quick Start Steps</td>
<td>3</td>
</tr>
<tr>
<td>Software Installation Procedures</td>
<td>4</td>
</tr>
<tr>
<td>Evaluation Board Setup Procedures</td>
<td>6</td>
</tr>
<tr>
<td>Evaluation Board Hardware</td>
<td>7</td>
</tr>
<tr>
<td>AD7402 Description</td>
<td>7</td>
</tr>
<tr>
<td>Power Supplies</td>
<td>7</td>
</tr>
<tr>
<td>Input Signals</td>
<td>7</td>
</tr>
<tr>
<td>Link Configuration Options</td>
<td>9</td>
</tr>
<tr>
<td>Setup Conditions</td>
<td>9</td>
</tr>
<tr>
<td>Evaluation Board Circuitry</td>
<td>10</td>
</tr>
<tr>
<td>Sockets/Connectors</td>
<td>10</td>
</tr>
<tr>
<td>Test Points</td>
<td>10</td>
</tr>
<tr>
<td>How to Use the Software</td>
<td>11</td>
</tr>
<tr>
<td>Starting the Software</td>
<td>11</td>
</tr>
<tr>
<td>Setting Up the System for Data Capture</td>
<td>11</td>
</tr>
<tr>
<td>Overview of the Main Window</td>
<td>12</td>
</tr>
<tr>
<td>Generating a Waveform Analysis Report</td>
<td>13</td>
</tr>
<tr>
<td>Generating a Histogram of the ADC Code Distribution</td>
<td>14</td>
</tr>
<tr>
<td>Generating a Fast Fourier Transform of AC Characteristics</td>
<td>15</td>
</tr>
<tr>
<td>Generating a Summary of the Waveform, Histogram, and Fast Fourier Transform</td>
<td>16</td>
</tr>
<tr>
<td>Saving Files</td>
<td>17</td>
</tr>
<tr>
<td>Printing a Screenshot</td>
<td>17</td>
</tr>
<tr>
<td>Opening Files</td>
<td>17</td>
</tr>
</tbody>
</table>

**REVISION HISTORY**

2/15—Revision 0: Initial Version
GETTING STARTED

QUICK START STEPS

Follow these steps to quickly evaluate the AD7402 ADC:

1. Install the evaluation software from the AD7402 product page or from the CD included in the EVAL-AD7402-8FMCZ evaluation board kit. Ensure that the EVAL-SDP-CH1Z board is disconnected from the USB port of the PC while installing the software. (The PC may need to be restarted after the installation)
2. Ensure that the various link options are configured as outlined in Table 2.
3. Connect the EVAL-SDP-CH1Z board to the evaluation board as shown in Figure 2.
4. Connect the EVAL-SDP-CH1Z board to the PC via the USB cable. For Windows® XP, you may need to search for the EVAL-SDP-CH1Z drivers. Choose to automatically search for the drivers for the EVAL-SDP-CH1Z board if prompted by the operating system.
5. Power up the EVAL-SDP-CH1Z by inserting the 12 V dc barrel jack (included with the EVAL-SDP-CH1Z) into the +12V_VIN barrel connector on the EVAL-SDP-CH1Z.
6. Launch the evaluation software from the Analog Devices subfolder in the Programs menu.
7. Connect an input signal via the J1 connector (AIN+).
SOFTWARE INSTALLATION PROCEDURES

The EVAL-AD7402-8FMCZ evaluation kit includes a CD containing evaluation software to be installed on your PC before you begin using the evaluation board.

There are two parts to the installation:

- EVAL-AD7402-8FMCZ evaluation software installation
- EVAL-SDP-CH1Z driver installation

**Warning**

The evaluation board software and drivers must be installed before connecting the evaluation board and EVAL-SDP-CH1Z board to the USB port of the PC to ensure that the evaluation system is correctly recognized when it is connected to the PC.

**Installing the EVAL-AD7402-8FMCZ Evaluation Board Software**

To install the EVAL-AD7402-8FMCZ evaluation board software,

1. Insert the included evaluation software installation CD into the CD drive of a Windows-based PC, and open the contents of the CD.
2. Double-click the `setup.exe` file to begin the installation. By default, the software is saved to the following location: `C:\Program Files\Analog Devices\AD7402-8\`
3. A dialog box appears asking for permission to allow the program to make changes to your computer. Click Yes to begin the installation process.
4. Select the location to install the software, and then click Next.
5. A license agreement appears. Read the agreement, select I accept the License Agreement, and click Next.
6. A summary of the installation is displayed. Click Next to continue.
7. A dialog box informs you when the evaluation software installation is complete. Click Next to proceed with the installation of the drivers.
Installing the EVAL-SDP-CH1Z System Demonstration Platform Board Drivers

After the installation of the evaluation board software is complete, the ADI SDP Drivers Setup wizard window opens for the installation of the EVAL-SDP-CH1Z system demonstration platform board drivers.

1. Make sure that all other applications are closed, and then click Next to begin the driver installation process.

2. Select the location to install the drivers, and then click Install.

3. Click Install to proceed with the installation.

4. To complete the drivers installation, click Finish, which closes the installation wizard.
EVALUATION BOARD SETUP PROCEDURES

The EVAL-AD7402-8FMCZ connects to the EVAL-SDP-CH1Z system demonstration platform. The EVAL-SDP-CH1Z board is the controller board, which is the communication link between the PC and the main evaluation board. Figure 2 shows a photograph of the connections between the EVAL-AD7402-8FMCZ daughter board and the EVAL-SDP-CH1Z controller board.

After following the instructions in the Software Installation Procedures section, set up the evaluation and SDP-H1 boards as detailed in this section.

Warning

The evaluation software and drivers must be installed before connecting the evaluation board and EVAL-SDP-CH1Z board to the USB port of the PC to ensure that the evaluation system is correctly recognized when it is connected to the PC.

Connecting the Evaluation and SDP Boards to a PC

1. Ensure that all configuration links are in the appropriate positions (see Table 2).
2. Connect the EVAL-AD7402-8FMCZ board securely to the J4 FMC connector on the EVAL-SDP-CH1Z board.
3. The EVAL-SDP-CH1Z board requires an external power supply adapter, which is included in the EVAL-SDP-CH1Z kit. Connect this power supply to the dc barrel connector labeled +12V_VIN on the EVAL-SDP-CH1Z board.
4. Connect the EVAL-SDP-CH1Z board to the PC via the USB cable enclosed in the EVAL-SDP-CH1Z kit.

Verifying the Board Connection

1. Allow the Found New Hardware Wizard to run after the EVAL-SDP-CH1Z board is plugged into your PC. (If you are using Windows XP, you may need to search for the EVAL-SDP-CH1Z drivers. Choose to automatically search for the drivers for the EVAL-SDP-CH1Z board if prompted by the operating system.)
2. Check that the board is connected to the PC correctly using the Device Manager of the PC.
   a. Access the Device Manager as follows:
      i. Right-click My Computer and then click Manage.
      ii. A dialog box appears asking for permission to allow the program to make changes to your computer. Click Yes.
      iii. The Computer Management box appears. From the list of System Tools, click Device Manager.
   b. Under ADI Development Tools, Analog Devices SDP-H1 should appear (see Figure 11), indicating that the EVAL-SDP-CH1Z driver software is installed and that the board is connected to the PC correctly.

Disconnecting the EVAL-AD7402-8FMCZ Board

Always remove power from the EVAL-SDP-CH1Z or click the reset tact switch (located alongside the mini-USB port) before removing the EVAL-AD7402-8FMCZ daughter board.
EVALUATION BOARD HARDWARE

AD7402 DESCRIPTION

This user guide describes the evaluation board for the AD7402 isolated ADC. The AD7402 is a second-order, Σ-Δ modulator that converts an analog input signal into a high speed, single-bit data stream with on-chip digital isolation based on the Analog Devices, Inc., iCoupler technology. The AD7402 operates from a 4.5 V to 5.5 V (VDD1) power supply and accepts a differential input signal of ±250 mV (±320 mV full scale). The differential input is ideally suited to shunt voltage monitoring in high voltage applications where galvanic isolation is required.

The analog input is continuously sampled by a high performance analog modulator and converted to a ones density, digital output stream with a data rate of 10 MHz. The original information can be reconstructed with an appropriate digital filter. The serial input/output can use a 3 V to 5 V or a 3.3 V supply (VDD2). The serial interface is digitally isolated. High speed CMOS, combined with monolithic transformer technology, allows the on-chip isolation to provide outstanding performance characteristics that are superior to the performance of alternatives, such as optocoupler devices. The AD7402 device is offered in an 8-lead, wide-body SOIC package and has an operating temperature range of −40°C to +105°C.

Complete specifications for the AD7402 device are provided in the AD7402 data sheet, which should be consulted in conjunction with this user guide when using the evaluation board. Full details on the EVAL-SDP-CH1Z are available on the SDP-H1 product page.

POWER SUPPLIES

Before applying power and signals to the evaluation board, ensure that all link positions are set according to the required operating mode. See Table 2 for the complete list of link options.

This evaluation board is designed to be supplied via the EVAL-SDP-CH1Z. The EVAL-SDP-CH1Z generates 12 V and 3.3 V supply rails. The 12 V supply is connected to the on-board 5 V linear regulator that supplies the ADuM6000 with power. The ADuM6000 generates an isolated 5 V supply to power the VDD1 rail of the AD7402. The 3.3 V supply rail from the EVAL-SDP-CH1Z supplies the VDD2 rail of the AD7402.

To supply VDD1 externally, connect an external power supply in the range of 24 V ± 5% to the HIGH_V connector, J7. Alternatively, connect an external supply in the range of 5 V ± 10% to the J5 connector.

VDD2 can also be supplied via an external power supply in the range of 3 V to 5.5 V via the J6 connector.

There are two main ground planes: GND1 and GND2. These planes are isolated with a creepage and clearance of 8 mm.

Caution

When the EVAL-AD7402-8FMCZ is connected to the EVAL-SDP-CH1Z, take care to ensure that if an external voltage is supplied to the J6 input connector, the voltage does not exceed 3.3 V. Exceeding this voltage may cause permanent damage to the EVAL-SDP-CH1Z board.

INPUT SIGNALS

The analog input range to the AD7402 is ±250 mV (±320 mV full scale), which must not be exceeded. Connect an input signal in the range of 500 mV p-p to the evaluation board via the VIN+ analog input connector, J1. The VIN− analog input connector, J2, is used for common-mode voltage rejection and can either be connected to ground of the source or GND1 of the EVAL-AD7402-8FMCZ by inserting LK8.

The EVAL-AD7402-8FMCZ has analog and digital ground planes that are physically isolated from one other. As such, power to the analog supply rail is by default supplied through the on-board ADuM6000 isolated iCoupler, 5 kV, dc-to-dc converter. VDD1 can optionally be supplied from the J5 external connector or from the J7 high voltage external connector. A 24 V supply connected to J7 is stepped down to 5 V by means of the on-board ADP2441 step-down dc-to-dc regulator. See Table 2 for more information about supplying VDD1 externally.

Table 1. External Power Supplies (Optional)

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>Connector</th>
<th>Voltage Range</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDD1</td>
<td>J5</td>
<td>5 V ± 10%</td>
<td>Analog supply rail</td>
</tr>
<tr>
<td>VDD2</td>
<td>J6</td>
<td>3 V to 5.5 V</td>
<td>Digital supply rail without EVAL-SDP-CH1Z connected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3.3 V ± 5%</td>
<td>Digital supply rail with EVAL-SDP-CH1Z connected</td>
</tr>
<tr>
<td>HIGH_V</td>
<td>J7</td>
<td>24 V ± 5%</td>
<td>Analog supply rail (high voltage alternative to J5)</td>
</tr>
</tbody>
</table>
Figure 12. EVAL-AD7402-8FMCZ Block Diagram
LINK CONFIGURATION OPTIONS

Multiple link options must be set correctly to select the appropriate operating setup before using the evaluation board. The functions of these options are outlined in Table 2.

SETUP CONDITIONS

Before applying power and signals to the evaluation board, ensure that all link positions are as required by the operating mode. There are two modes in which to operate the evaluation board. The evaluation board can be operated in SDP-H1 controlled mode to be used with the EVAL-SDP-CH1Z board, or the evaluation board can be used in standalone mode.

The Default Position column of Table 2 shows the default positions in which the links are set when the evaluation board is packaged. When the board is shipped, it is set up to operate in SDP-H1 controlled mode, with the power supplied from the EVAL-SDP-CH1Z board and the analog supply rail (VDD1) supplied via the on-board, isoPower® ADuM6000 dc-to-dc converter.

Table 2. Link Options

<table>
<thead>
<tr>
<th>Category</th>
<th>Link</th>
<th>Default Position</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Supplies</td>
<td>LK1</td>
<td>A</td>
<td>This link selects the AD7402 VDD1 supply source. Remove LK5 if using either Position A or Position B. Position A: VDD1 is supplied from the ADuM6000 on-board device. Position B: VDD1 is supplied externally via Connector J5.</td>
</tr>
<tr>
<td></td>
<td>LK5</td>
<td>Removed</td>
<td>When LK5 is inserted, VDD1 is supplied via a step-down dc-to-dc regulator via J7. Remove LK5 if VDD1 is supplied via LK1.</td>
</tr>
<tr>
<td></td>
<td>LK2</td>
<td>A</td>
<td>This link selects the AD7402 VDD2 supply source. Position A: VDD2 is supplied from the EVAL-SDP-CH1Z board. Position B: VDD2 is supplied from the on-board 5 V regulator. Position C: VDD2 is supplied externally via Connector J6.</td>
</tr>
<tr>
<td>Analog Input</td>
<td>LK7</td>
<td>Removed</td>
<td>When LK7 is inserted, AIN+ is shorted to ground. Remove LK7 if a signal is applied to AIN+.</td>
</tr>
<tr>
<td></td>
<td>LK8</td>
<td>Inserted</td>
<td>When LK8 is inserted, AIN− is shorted to ground. Remove LK8 if a signal is applied to AIN−.</td>
</tr>
<tr>
<td>Serial Interface</td>
<td>LK3</td>
<td>B</td>
<td>This link is used to select the MCLKOUT destination. Position A: Do not use. Position B: MCLKOUT is sent to the EVAL-SDP-CH1Z board. Position C: MCLKOUT is sent to the J3 SMB jack. (Standalone mode.)</td>
</tr>
<tr>
<td></td>
<td>LK4</td>
<td>A</td>
<td>This link is used to route the MDAT output for the serial interface. Position A: MDAT is sent to the EVAL-SDP-CH1Z board. Position B: MDAT is sent to the J4 SMB jack. (Standalone mode.)</td>
</tr>
</tbody>
</table>
EVALUATION BOARD CIRCUITRY

SOCKETS/CONNECTORS

The connectors and sockets on the EVAL-AD7402-8FMCZ are described in Table 3.

Table 3. On-Board Connectors

<table>
<thead>
<tr>
<th>Connector</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1</td>
<td>Analog input AIN+</td>
</tr>
<tr>
<td>J2</td>
<td>Analog input AIN−</td>
</tr>
<tr>
<td>J3</td>
<td>MCLKOUT output—standalone mode</td>
</tr>
<tr>
<td>J4</td>
<td>MDAT output—standalone mode</td>
</tr>
<tr>
<td>J5</td>
<td>VDD1 external source</td>
</tr>
<tr>
<td>J6</td>
<td>VDD2 external source</td>
</tr>
<tr>
<td>J7</td>
<td>VDD1 external source—high voltage</td>
</tr>
</tbody>
</table>

The default interface to this evaluation board is via the FMC connector, which connects the EVAL-AD7402-8FMCZ to the EVAL-SDP-CH1Z board. If the EVAL-AD7402-8FMCZ board is used in standalone mode, communication is achieved via the J3 and J4 SMB jacks. See Table 2 for more information about configuring the evaluation board for standalone mode.

TEST POINTS

There are several test points on the EVAL-AD7402-8FMCZ board. These test points provide easy access to the signals from the evaluation board for probing, evaluation, and debugging.
HOW TO USE THE SOFTWARE

STARTING THE SOFTWARE

After the EVAL-AD7402-8FMCZ and EVAL-SDP-CH1Z boards are correctly connected to the PC, start the evaluation software.

1. From the Start menu, click Programs > Analog Devices > AD7402-8. The main window of the software opens (see Figure 14).

2. If the EVAL-AD7402-8FMCZ evaluation board is not connected to the USB port via the EVAL-SDP-CH1Z when the software is launched, a connectivity error displays (see Figure 13). Connect the evaluation system to the USB port of the PC and wait a few seconds, and then click Rescan and follow the instructions.

SETTING UP THE SYSTEM FOR DATA CAPTURE

After completing the steps in the Software Installation Procedures and Evaluation Board Setup Procedures sections, set up the system for data capture as follows:

1. Select the appropriate FPGA Settings.
2. Click Single Capture or Continuous Capture.

Figure 13. Connectivity Error Alert

Figure 14. Evaluation Software Main Window
OVERVIEW OF THE MAIN WINDOW

The main window of the software is shown in Figure 14 and has the features described in this section. These features include the following:

- Menu bar
- Control buttons
- FPGA configuration options
- Data capture display
- AC/DC analysis

Menu Bar

The menu bar (labeled 1 in Figure 14) consists of the File, Edit, and Help menus.

File Menu

The File menu offers the following options:

- **Save Captured Data**: save captured data in comma separated values (.csv) format for future analysis.
- **Load Captured Data**: load previously captured data in .csv format for analysis.
- **Take Screenshot**: save a screenshot of the window as a .jpeg file.
- **Print Screenshot**: print a screenshot of the window to the default printer.
- **Exit**: close the application.

Edit Menu

The Edit menu offers the following option:

- **Reinitialize to default**: place the evaluation board in a known default state.

Help Menu

The Help menu offers the following options:

- **Analog Devices Website**: open the Analog Devices website in the default browser.
- **Context Help**: turn on context-sensitive help.
- **About**: provide evaluation kit information.

Control Buttons, Drop-Down Boxes, and Indicators

The evaluation software includes the following control buttons, drop-down boxes, and indicators:

- The **Eval Board Connected** box (labeled 2 in Figure 14) indicates whether the EVAL-AD7402-8FMCZ board has been detected.
- The **FPGA Settings** section (labeled 6 in Figure 14) specifies the MCLKOUT frequency used for the serial interface and the decimation ratio used by the FPGA to filter the data.
- The **Samples** drop-down box (labeled 4 in Figure 14) allows selecting the number of samples to be captured in a single acquisition.
- Clicking **Single Capture** (see label 5 in Figure 14) initiates the sampling and readback of the number of measurements defined in the Samples box.
- Clicking **Continuous Capture** (see label 5 in Figure 14) performs a continuous capture from the ADC. Clicking **Continuous Capture** a second time stops sampling.

Window Tabs

There are five tabs available in the tabs area (labeled 3 in Figure 14) of the main window: **Configure**, **Waveform**, **Histogram**, **FFT**, and **Summary**. These tabs are used to switch among device configuration, waveform analysis, histogram analysis, FFT analysis, and a summary of the last capture.

Each tab is described in more detail in the Generating a Waveform Analysis Report; Generating a Histogram of the ADC Code Distribution; Generating a Fast Fourier Transform of AC Characteristics; and Generating a Summary of the Waveform, Histogram, and Fast Fourier Transform sections.

Graph Tools

Graph tools are provided within each tab to allow you to control the cursor, zooming, and panning (see Figure 15) within the graphs displayed.

![Graph Tools Image](image-url)
GENERATING A WAVEFORM ANALYSIS REPORT

Figure 16 shows the tab used for a waveform capture. Click **Single Capture** or **Continuous Capture** (labeled 1 in Figure 16) to capture samples from the ADC and graph the resulting waveform.

Graph controls (labeled 2 in Figure 16) are located above the graph and can be used to pan and zoom into particular areas of the graph (see the Graph Tools section and Figure 15 for more information).

The **Waveform Analysis** area (labeled 3 in Figure 16) shows statistics pertaining to the captured waveform, such as maximum, minimum, and mean amplitudes and signal frequency.

---

**Figure 16. Waveform Capture Tab**
GENERATING A HISTOGRAM OF THE ADC CODE DISTRIBUTION

The **Histogram** tab can be used to perform ac testing or, more commonly, dc testing. This tab shows the ADC code distribution of the input and computes the mean and standard deviation, which are displayed as **DC Offset/Mean** and **Transition Noise**, respectively, in the **Histogram Analysis** area (labeled 2 in Figure 17).

**AC Input**

To perform a histogram test of ac input,
1. Apply a quality signal source to the VIN+ input on the board.
2. Click the **Histogram** tab from the main window.
3. Click **Single Capture** or **Continuous Capture** (labeled 1 in Figure 17).

Raw data is then captured and passed to the PC for statistical computations, and various measured values are displayed in the **Histogram Analysis** area (labeled 2 in Figure 17).

**DC Input**

A histogram test of dc input can be performed with or without an external source because the evaluation board can be configured with grounded inputs.

To perform a histogram test of dc input,
1. If an external source is being used, apply a signal source to the selected analog input. It may be required to filter the signal to ensure that the dc source is noise-compatible with the ADC.
2. Click the **Histogram** tab from the main window.
3. Click **Single Capture** or **Continuous Capture** (labeled 1 in Figure 17).

Raw data is then captured and passed to the PC for statistical computations, and various measured values are displayed in the **Histogram Analysis** area (labeled 2 in Figure 17).

![Figure 17. Histogram Capture Tab](image)
GENERATING A FAST FOURIER TRANSFORM OF AC CHARACTERISTICS

Figure 18 shows the FFT tab. This feature tests the traditional ac characteristics of the converter and displays a fast Fourier transform (FFT) of the results.

To perform an ac FFT test,

1. Apply a bipolar sinusoidal signal with low distortion (better than 115 dB) to the evaluation board at the VIN+ input. To attain the requisite low distortion, which is necessary to allow true evaluation of the part, one option is to filter the input signal from the ac source. Choose an appropriate band-pass filter based on the sinusoidal signal applied.

2. Click the FFT tab from the main window.

3. Click Single Capture or Continuous Capture.

Figure 18 displays the spectral analysis results of the captured data.

- The plot is the FFT image of the raw data.
- The FFT Analysis box displays the performance data: SNR, THD, SINAD, dynamic range, and noise performance along with the input signal characteristics (see label 1 in Figure 18).
- Clicking Show Harmonic Content (see label 2 in Figure 18) displays the frequency and amplitude of the fundamental in addition to the second to fifth harmonics.
GENERATING A SUMMARY OF THE WAVEFORM, HISTOGRAM, AND FAST FOURIER TRANSFORM

Figure 19 shows the Summary tab. This tab captures and displays all of the information in one window with a synopsis of the information, including key performance parameters, such as SNR and THD (see the SNR and THD boxes, labeled 1 and 2, respectively, in Figure 19).

Figure 19. Summary Tab
SAVING FILES
The software can save the current captured data for future analysis. The software also has the ability to save or print a screenshot of the currently displayed window.

Saving Captured Data
To save data, from the File menu, click Save Captured Data. The Save As dialog box shown in Figure 20 opens. Save the file to an appropriate folder location. Waveform data is saved in .csv format and can be opened for further analysis in other software, such as Excel or MATLAB®.

Figure 20. Dialog Box for Saving a File

Saving a Screenshot
To save a screenshot, from the File menu, click Take Screenshot. The Select the JPEG file to write dialog box in Figure 21 opens. Save the file to an appropriate folder location. Screenshots are saved in .jpeg format and can be viewed with any picture viewer/editor.

Figure 21. Dialog Box for Saving a Screenshot

PRINTING A SCREENSHOT
To print a screenshot, from the File menu, click Print Screenshot. The screenshot is sent to the default printer. No dialog box appears when printing a screenshot.

OPENING FILES
Loading Captured Data
The software can load previously captured data for analysis. From the File menu, click Load Captured Data. Only data that was previously captured and saved can be opened. The raw data is used to rebuild the histogram and ac spectrum analyses upon being loaded into the evaluation platform.

When Load Captured Data is selected, the Open file dialog box in Figure 22 opens for loading an appropriate file. The evaluation software expects that a previously generated waveform file is in .csv format.

Figure 22. Dialog Box for Opening a File
ESD Caution
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.